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New Features and Product Enhancements
The 2022.1 software release for Dragonfly and Dragonfly Pro marks the integration of 
NASA’s Porous Microstructure Analysis (PuMA) software for performing material 
response simulations and the introduction of noise-to-void denoising, in which training 
is done directly on the data to be denoised. Significant enhancements for the Deep 
Learning Tool, Segmentation Wizard, and Dragonfly’s CT Reconstruction module, as well 
as new vector fields options examining simulation results and modeling anisotropy, 
tortuosity analysis for graphs, particle roughness calculations, and summary reports are 
also included in Dragonfly 2022.1.

Porous Microstructure Analysis (PuMA)

For the computation of effective material properties and for performing material 
response simulations on microstructures of porous media, this software release includes 
the first integration of NASA’s Porous Microstructure Analysis (PuMA) software.

PuMA is able to generate artificial microstructures that mimic real-world materials and 
to compute morphological properties such as porosity, volume fractions, pore diameter, 
and surface area. Additional capabilities include the determination of effective thermal 
conductivity, permeability, tortuosity and diffusivity from the continuum, and 
techniques to determine local material orientation.

PuMA simulation results

Choose Workflows > PuMA on the menu bar to open the Porous Microstructure Analysis 
(PuMA) dialog. The dialog includes a Sample Generator tab, on which you can create a 
number of different artificial microstructures, and a Solver tab, on which you can 
compute various material properties.
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PuMA’s Sample Generator tab (on left) and Solver tab (on right)

Sample Generator

You can generate random fiber and random sphere specimens with PuMA’s Sample 
Generator. You can select a size for the datasets and effective porosity, as well as 
specify a number of additional parameters such as radius, length, orientation, and 
intersection for fibers. The parameters for spheres include diameter and intersection.

Solver

Inputs for PuMA’s Solver include generated random fiber and sphere specimens, as well 
as datasets of real-world materials and segmentations saved as multi-ROIs. You can 
compute continuum tortuosity, permeability, thermal conductivity, as well as determine 
local orientation. In addition, you can publish 3D images of concentration fields for 
tortuosity, velocity and pressure for permeability, as well as temperature fields and flux 
for thermal conductivity.

System Requirements

The following are the recommended minimum requirements for working with PuMA, 
which can vary depending on the material properties that are studied.

• 16-32 GB of RAM for small to medium simulations.

• 32+ GB of RAM for larger simulations.

NOTE For more information about the requirements for PuMA and other topics, go to
https://puma-nasa.readthedocs.io/en/latest/.
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Licensing

This feature for numerical simulation and material property characterization, which is 
under continued development, is available to non-commercial license holders and is 
also included for commercial license holders in the Dragonfly 2022.1 release. However, 
holders of a commercial license will need to upgrade their current license to continue 
using PuMA in future releases of Dragonfly. Please contact Sales for all questions about 
licensing terms and costs.

References

Refer to the following publications for more information about PuMA.

• Joseph C. Ferguson, Francesco Panerai, Arnaud Borner, Nagi N. Mansour, PuMA: the 
Porous Microstructure Analysis software. SoftwareX, Vol. 7, January–June 2018, 
Pages 81-87 (https://doi.org/10.1016/J.SOFTX.2018.03.001).

• Joseph C. Ferguson, Federico Semeraro, John M. Thornton, Francesco Panerai, Arnaud 
Borner, Nagi N. Mansour, Update 3.0 to “PuMA: the Porous Microstructure Analysis 
software”, (PII:S2352711018300281). SoftwareX, Vol. 15, July 2021, 100775 
(https://doi.org/10.1016/J.SOFTX.2021.100775).
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Noise2Void Deep Learning Model for Denoising

Training deep-learning models for denoising usually relies on either pairing high-noise 
input images with low-noise output images or using independent pairs of noisy images 
in an approach known as Noise2Noise (N2N). These approaches can be limited if the 
acquisition of low-noise or noisy training targets is not possible, as is often the case for 
biomedical image studies. As an additional option for training deep-learning models for 
denoising, this Dragonfly release includes the option to apply an approach known as 
Noise2Void (N2V), in which training is done directly on the data to be denoised.

Below is an example of the results for applying a trained N2V model.

Original image (on left) compared with denoised version (on right)

Advantages of Noise2Void Denoising

• Other classic deep-learning models for denoising, such as noise-to-low noise and 
noise-to-noise, may not be usable if the required outputs cannot be acquired. For 
Noise2Void models, each pixel is replaced with another pixel in the same image.

• Training N2V models usually does not require many epochs.

• N2V models are very good for reducing salt and pepper noise.

You should note that in some cases N2V may not outperform other methods that 
have more training information. For example, denoising performance may drop if 
structured noise is present.

NOTE Refer to Alexander Krull, Tim-Oliver Buchholz, Florian Jug: Noise2Void - Learning 
Denoising from Single Noisy Images. CoRR abs/1811.10980 (2018) for more information 
about this denoising approach (available online at https://arxiv.org/abs/1811.10980).
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Choose Artificial Intelligence > Custom Deep Model Architectures > Noise2Void on the 
menu bar to open the Noise2Void dialog. The dialog contains a number of tabs — Apply 
and Train — that let you configure and complete a model training workflow, as well as 
apply a trained model to denoise a dataset.

The options on the Train tab, shown below, let you generate new models and then train 
them on a selected dataset. You should note that most of the functionalities — Model, 
Inputs, Data augmentation, Training parameters, and Preview — are the same as those 
available in the Deep Learning Tool dialog.

Noise2Void dialog
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U-Net SR Deep Learning Model for Super Resolution

The term “Super Resolution” refers to the process of improving the quality of images by 
boosting its resolution. In most cases, a trained super resolution model can transform 
images from low-resolution (LR) to high-resolution (HR) while maintaining clean edges 
and preserving important details.

This software release includes a modified U-Net network architecture — U-Net SR — for 
super resolution that employs a mixed gradient loss that reduces the number of 
parameters. This method may provide better performance and accelerate inference 
compared with other super-resolution algorithms.

U-Net SR is available in the Model Generator dialog for super-resolution architectures. 
You should note that an initial set of training parameters, which should work well in 
most cases, are pre-configured for this model and that your training data must include 
high-resolution output images that are an exact multiple of the input images, such as 
2x, 4x, 6x, and so on. You will need to enter the Scale value of the output images when 
you set the parameters for the model, as shown below. 

Model Generator dialog
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You should note that only datasets that meet the selected scale value will appear in the 
Output drop-down menu on the Inputs tab when you go to training and choose your 
training data. 

NOTE Refer to Zhengyang Lu, Ying Chen: Single Image Super Resolution based on a Modified 
U-net with Mixed Gradient for more information about this super resolution approach 
(available online at https://arxiv.org/abs/1911.09428v1).
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Deep Learning Updates

Updates for Dragonfly’s Deep Learning Tool include selectable class weights, changes 
for the Training and Model Generator dialogs, and the option to export plotted graphs 
and visual feedback image sequences as a video file.

Selectable Class Weights

In some cases, training datasets may have a significant class imbalance or all phases 
may have similar greyscale values. To help improve the training of semantic 
segmentation models for such cases with the Deep Learning Tool, this software release 
lets you select data proportional and custom class weights to solve class imbalance 
problems and to accelerate training.

Class weights are selectable on the Model Overview panel in the Classes box, as shown 
below.

Deep Learning Tool dialog

For following class weights are available for semantic segmentation models.

Class weights 

NOTE Custom class weights are not yet available for the Segmentation Wizard. However, 
custom class weights set in the Deep Learning Tool will be propagated to any model 
imported into the Segmentation Wizard that was trained in the Deep Learning Tool.

Description

Uniform Class weights are applied uniformly, regardless of labeling.

Computed from labeling Class weights will be recomputed at training time as an inverse proportion of the labels in the training 
data, as shown below.

Custom Lets you set custom class weights.

• You can increase weight if not many labels are available.

• You can decrease weight for background and/or unimportant features.
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Training Progress Information

The Training dialog, which can provide visual feedback for monitoring training, now 
includes detailed information about the model being trained and the model input(s). As 
shown below, the collapsible Information box at the top of the dialog includes a 
description of the model, the training parameters, data augmentation settings, and 
information about the training data.

Training dialog

Export Visual Feedback

You should note that the option to export the graph and visual feedback image 
sequence as a video file is now available from the Training Results dialog for models 
with the checkpoint cache and visual feedback options enabled.

The Export Movie option is circled on the following screen capture.
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Training Results dialog

Do the following to export a video of the plotted graph and visual feedback image 
sequence:

1. Right-click the required model in the Deep Learning Tool and then choose Display 
Training History and the appropriate training session in the pop-up menu.

The Training Results dialog appears.

2. Click the Export Movie button.

3. Choose the required frames-per-second setting (FPS) in the Choose an FPS dialog, 
as shown below.

4. Click OK and then choose a file name and type — AVI, MKV, or animated GIF — in 
the Export Visual Feedback to File dialog.

5. Click Save.
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Model Generator

This software release includes a minor refactoring of the Model Generator dialog. You 
should note that the input dimension options, circled below, are now listed as 2D, 2.5D, 
and 3D.

Model Generator dialog
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Segmentation Wizard

The following new features and updates are available for the Segmentation Wizard in 
this software release.

Frame Role Assignment

The role assignment for frames has been expanded for Dragonfly 2022.1 to include the 
options ‘Not used’, ‘Training’, ‘Validation’, and ‘Evaluation’. Previously, these roles were 
limited to ‘Mixed’ and ‘Monitoring’.

Input tab

The following settings are available for frames.

Frame assignments 

Frame Statistics

The Frame Statistics dialog was updated to provide additional information about 
labeling and the set usage of each frame.

Click the Show Statistics button in the Frames box on the Input tab to open the Frame 
Statistics dialog, which is shown in the following screen capture. 

Description

Not used The frame will not be considered.

Mixed The frame will be randomly split into training, validation, and evaluation patches.

NOTE This is default setting for frames.

Training The frame will be used exclusively to learn model parameters.

Validation The frame will be used exclusively for model validation during training.

NOTE Applicable for deep model training only.

Evaluation The frame will be used to calculate model scores.

Monitoring The frame will be used to show visual feedback during training.

NOTE Only one frame can be designated for visual feedback. If you set a second frame to ‘Monitoring’, the 
original monitoring frame well be reset to ‘Mixed’ automatically.
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Frame Statistics dialog

Frame Names and Fitting

You should note that frame names now appear in the main view, as circled below. You 
should also note that frames can be fit by simply clicking the frame or selecting it on the 
Input panel. Multiple frames can also be fit automatically if they are on the same slice.

Segmentation Wizard workspace
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Data Proportional Class Weights

To improve the training of semantic segmentation models in cases with significant class 
imbalances, this software release provides the option to use class weights that are 
inversely proportional to the labeled training data.

Open the Settings tab, shown below, to select data proportional class weights for 
training deep models. If not checked, uniform weights will be applied.

Settings tab

Computing Model Scores

You can now choose to compute the score for a particular model by clicking the 
Compute Score button, circled below, in the Model list on the Models tab.

Models tab

NOTE You still compute a global update by clicking the Compute All Scores button, which is 
below the models list.
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Scalar Generator Updates

A number of new measurements are available in this software release for characterizing 
and measuring object properties, as well as for cross-indexing.

Estimations of Roughness

Dragonfly 2022.1 provides a number of new 3D measurements for estimating the 
surface ‘roughness’ of quasi-spherical particles or objects. Roughness, which plays an 
important role in various processes, such as for the quality assurance of powders, can 
be defined as the deviation of a real surface from its ideally smooth form.

Right-click a multi-ROI and then choose Scalar Generator in the pop-up menu. 
Roughness estimators, as well as convex hull surface area measurements, are available 
in the Basic Measurements category, as circled below.

Scalar Generator

The following are available in the Scalar Generator for computing roughness and convex 
hull surface areas. You should note that in many cases roughness cannot be accurately 
characterized using a single parameter.

Convex hull and roughness measurements

Description

Convex Hull Surface Area 
(voxel-wise)

Is the surface area of the convex hull of the particle, computed voxel-wise, i.e. the area of the exposed 
faces of voxels is summed.

Convex Hull Surface Area 

(Lorensen 1987)1
Is the surface area of the convex hull of the particle, computed using the marching cubes algorithm.

Convex Hull Surface Area 

(Lindblad 2005)2
Is the surface area of the convex hull of the particle, computed using the Lindblad surface area estimator 
method.

NOTE The Lindblad surface area estimator is usually a more robust measurement than the voxel-wise 
method.
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1 William E. Lorensen, Harvey E. Cline, Marching Cubes: A High Resolution 3D Surface Construction Algorithm. ACM SIGGRAPH Computer 

Graphics, 21(4), July 1987, pp 163-169. DOI:https://doi.org/10.1145/37402.37422.
2 Joakim Lindblad, Surface area estimation of digitized 3D objects using weighted local configurations. Image and Vision Computing, 23, 2005, pp 

111-122. DOI:10.1016/j.imavis.2004.06.012.
3 Thomas Heenan, Alice Llewellyn, Andrew Leach, Matthew Kok, Chun Tan, Rhodri Jervis, Dan Brett, Paul Shearing, Resolving Li-Ion Battery 

Electrode Particles Using Rapid Lab-Based X-Ray Nano-Computed Tomography for High-Throughput Quantification. Advanced Science, 7(12), 

June 2020. DOI:10.1002/advs.202000362.

3D Solidity (voxel-wise) Is the ratio of the surface area to the convex hull surface area. A value of 1 signifies a perfectly smooth 
and solid distinct object, while a value less than or greater then 1 signifies an object having an irregular 
boundary or that contains holes.

NOTE In this case, measurements of surface area are computed voxel-wise.

3D Solidity (Lorensen 1987)1 Is the ratio of the surface area to the convex hull surface area. A value of 1 signifies a perfectly smooth 
and solid distinct object, while a value less than or greater then 0 signifies an object having an irregular 
boundary or that contains holes.

NOTE In this case, measurements of surface area are computed using the marching cubes algorithm.

3D Solidity (Lindblad 2005)2 Is the ratio of the surface area to the convex hull surface area. A value of 1 signifies a perfectly smooth 
and solid distinct object, while a value less than or greater then 1 signifies an object having an irregular 
boundary or that contains holes.

NOTE In this case, measurements of surface area are computed using the Lindblad surface area 
estimator.

Total Roughness Proxy XY
Total Roughness Proxy YZ
Total Roughness Proxy XX
Total Roughness Proxy XYZ

(Heenan 2020)3

Total Roughness Proxy XY/YZ/XZ is a proxy measurement that reports the roughness of particles, which 
are pre-supposed to be approximately spherical. A marching cubes mesh of the particle is computed and 
then resampled along the particle’s median plane in XY, YZ, or XZ. In that plane, the maximum and 
minimum radius of the resampled surface contour is computed from the object’s centroid. The Total 
Roughness Proxy is the difference of the maximum and minimum radius, as shown below.

The Total Roughness Proxy XYZ reports the difference of the minimum radius observed over all three 
planes from the maximum observed over all three planes.

NOTE This measurement is based on the method proposed by Thomas Heenan2 and should be 
considered as only a proxy for roughness. In addition, metrics such as this can possess fractal properties 
and are dependent upon characterization resolution both in terms of voxel or spatial resolution and the 
angular increment.

Total Roughness: Particle 
Radius Range

Total Roughness: Particle 
Radius Standard Deviation

Are measurements that report the roughness of particles, which are pre-supposed to be approximately 
spherical. A marching cubes mesh of the particle is computed, and then the radius is evaluated for all 
positions on the surface of that mesh from the object’s centroid.

Total Roughness: Particle Radius Range… Reports the difference between the maximum radius (not 
constrained to any planes) and the minimum radius.

Total Roughness: Particle Radius Standard Deviation… Reports the standard deviation of all radii 
evaluated.

Particle Radius Min
Particle Radius Max
Particle Radius Mean

Are measurements that report the radius of particles. A marching cubes mesh of the particle is computed, 
and then the radius is evaluated for all positions on the surface of that mesh from the object’s centroid.

Particle Radius Min… Reports the minimum of all evaluated radii.

Particle Radius Max… Reports the maximum of all evaluated radii.

Particle Radius Mean… Reports the mean of all evaluated radii.

Description

M
ax

im
um

Minimum

total roughness proxy = rmax - rmin
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Estimation of Sphericity

As an additional metric to characterize the 3D shape of particles, this Dragonfly release 
provides an estimator for sphericity that leverages the relation between the particle 
volume and surface area. This ratio, which can quickly estimate 3D sphericity, is 
computed as follows:

In the above, Vp is the volume of the particle and Ap is the surface area of the particle. 
In this case, the surface area is computed using the Lindblad surface area estimator 
method.

Right-click a multi-ROI and then choose Scalar Generator in the pop-up menu to open 
the Scalar Generator dialog. Sphericity is available in the Basic Measurements category, 
as circled below.

Scalar Generator

NOTE For more information about the implemented surface area estimator method, refer to 
Joakim Lindblad, Surface area estimation of digitized 3D objects using weighted local 
configurations. Image and Vision Computing, 23, 2005, pp 111-122. DOI:10.1016/
j.imavis.2004.06.012.
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Feret Measurements

Measurements of the maximum and minimum Ferets, as well as 2D Feret angles, are 
now available in the Scalar Generator for single-slice multi-ROIs. You should note that 
Ferets are computed from the center of the voxels that comprise the generated convex 
hull of each labeled object.

Right-click a multi-ROI and then choose Scalar Generator in the pop-up menu to open 
the Scalar Generator dialog. Feret measurements are available in the 2D Measurements 
category, as circled below.

Scalar Generator

The following Feret measurements are available in the Scalar Generator for 2D multi-
ROIs.

2D Feret measurements

Description

2D Max Feret Is the longest distance between any two parallel tangents along each labeled object’s convex hull. Can 
also be referred to as the maximum caliper diameter.

2D Min Feret Is the shortest distance between any two parallel tangents along each labeled object’s convex hull. Can 
also be referred to as the minimum caliper diameter.

2D Feret Angle Is the angle (0 to 180 degrees) of the 2D max Feret.



24 New Feature s  and Produc t  Enhancement s
Scalar Generator Updates

Dragonfly Release Notes Version 2022.1

T
M

0
2

1
-A

-1
1

Cross Indexing

For multi-ROIs with scalar values, the new Cross-Indexing option lets you cross-index 
the label number of the selected multi-ROI’s classes to the intersecting classes of 
another multi-ROI.

As shown below, you can choose a measurement title and the cross-indexed multi-ROI 
in the Scalar Generator dialog.

Scalar Generator

As shown in the example below, the Cross-Indexing column shows the intersecting label 
index of the referenced multi-ROI. You should note that a value of 0 indicates that the 
label of the selected multi-ROI does not intersect with any labels of the referenced 
multi-ROI. In addition, in cases in which a label intersects with multiple labels, the first 
intersecting label will be reported.

Exported scalar values
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Vector Fields from Datasets

This software release provides the option to generate vector fields from datasets. For 
example, to further examine pressure and velocity data published from permeability 
simulations created in Dragonfly’s new Porous Microstructure Analysis (PuMA) module 
(see Porous Microstructure Analysis (PuMA) on page 6).

A vector field generated from a PuMA permeability simulation is shown below.

Vector field within a pore network model

Do the following to create a vector field from datasets:

1. Right-click the datasets that you want use to generate the vector field in the Data 
Properties and Settings panel and then choose Generate Vector Field from Datasets 
in the pop-up menu.

NOTE You need to select at least two datasets to access the menu item.
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2. Select the datasets that will provide the X, Y, and Z vectors in the Choose Vector 
Field Component dialog, as shown below, in the Vector X, Y, and Z drop-down 
menus.

3. Select the dataset that will provide the vector modulus in the Vector Modulus drop-
down menu.

4. Set a sampling rate, as required.

5. Click OK the generate the vector field.

The generated vector field appears as a new item on the Data Properties and 
Settings panel. You can examine the vector field in a 3D view.
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Anisotropy Vector Fields

3D modeling of anisotropy can help determine associations between observed structural 
features and the mechanical function of a bone. With the property of being directionally 
dependent, anisotropy is presented as a 3D vector field in which color scales represent 
magnitude or direction and density is configurable. An example of a vector field 
computed for segmented trabecular bone is shown below.

Mapping of surface normal anisotropy by magnitude (on left) and direction (on right)

Right-click the required region of interest or mesh in the Data Properties and Settings 
panel and then choose 3D Modeling > Create an Anisotropy Vector Field to open the 
dialog shown below.

Create an Anisotropy Vector Field dialog
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The following settings are available for creating anisotropy vector fields.

Settings for creating anisotropy vector fields

NOTE Dragonfly also provides a dedicated module for advanced bone analysis that includes a 
guided workflow with automated segmentation of cortical and trabecular bone, 
morphometric measurements, additional options for measurements of anisotropy, and 
volume fraction mapping. Go to www.theobjects.com/dragonfly/bone-analysis.html for 
additional information about the Bone Analysis module.

Tortuosity Analysis for Graphs

As a new feature for computed graphs, you can analyze graph tortuosity and throat-
weighted tortuosity between selected input and output boxes. You should note that 
tortuosity is a measure of the departure of a porous medium from the ideal system 
made of straight and parallel capillaries. Tortuosity analysis and throat-weighted 
analysis results — Mean, Min, Max, and STD — appear as shown below.

Tortuosity analysis results (left) and throat-weighted tortuosity analysis results (right)

Description

Algorithm The Surface normals algorithm is based on the construction of a surface mesh populated by a set of 
vectors perpendicular to the mesh faces with their magnitude being proportional to the local mesh face 
area.

NOTE The degree of anisotropy (DA) is a measure of how highly oriented substructures are within a 
volume. For an isotropic (perfectly oriented) system, the degree of anisotropy would be equal to 0. As a 
system becomes more anisotropic (less well-oriented), the DA increases to some value less than or equal 
to 1.

Sampling Lets you choose the sampling settings as follows:

Area box… Defines the area for computing the vector field. Box shapes can be resized and/or reoriented 
as required. You can also add multiple boxes to compute anisotropy in different orientations.

Spacing… Determines the distance between the random points in the analysis area. You can also limit 
computations to a single voxel in the direction of the smallest length of the selected area box by checking 
the ‘Use single voxel in direction with smaller box length’ option. 

Grid size… Indicates the current grid size, which is computed as: area box lengths/spacing.

Neighbours Lets you choose the sampling settings as follows:

Radius of influence… Defines the kernel size, or elementary volume, within which anisotropy will be 
evaluated. You should note that a too small radius of influence may result in a low signal-to-noise ratio, 
while a too high radius can result in averaging and edge effects.

Anisotropy evaluation… Lets you choose an evaluation method — Projection-based or Eigenvalue-
based. You should note that both methods provide similar results, although you may find that the 
projection-based method is slightly more sensitive.

Mesh smoothing Determines the number of times that the mesh obtained from the input ROI will be smoothed before 
anisotropy is computed.

NOTE Selecting one or two iterations usually provides for the most accurate results.
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Analyzing Graph Tortuosity

Do the following to analyze tortuosity within a graph of porous media:

1. Add box shapes that define the input and output of the segment of the graph that 
you want to analyze.

2. Right-click the required graph in the Data Properties and Settings panel and then 
choose Graph Tortuosity Analysis in the pop-up menu.

3. Choose the required input and output boxes, as shown below.

4. Click OK to compute tortuosity measurements within the selected segment.

Analyzing Graph Throat-Weighted Tortuosity

Do the following to analyze throat-weighted tortuosity within a graph of porous media:

1. Add box shapes that define the input and output of the segment of the graph that 
you want to analyze.

2. Right-click the required graph in the Data Properties and Settings panel and then 
choose Graph Throat Weighted Tortuosity Analysis in the pop-up menu.

3. Choose the region of interest used to compute the graph, as well as the required 
input and output boxes, as shown below.

4. Click OK to compute throat-weighted tortuosity measurements within the selected 
segment of the graph.
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CT Reconstruction

This software release features a refactoring of the CT Reconstruction dialog, as well as 
the integration of RTK for the reconstruction of parallel-beam projections and the 
addition of SART for the reconstruction of cone-beam projections. You should note that 
RTK is an open-source software package based on the Insight Toolkit (ITK).

Choose Workflows > CT Reconstruction on the menu bar to open the CT Reconstruction 
dialog, shown below.

CT Reconstruction dialog
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Input image… Lets you choose the projection dataset that you want to reconstruct.

Geometry acquisition… Lets you import the geometry acquisition parameters from a 
text file or to manually enter the geometry.

Reconstruction engine… Lets you choose a reconstruction engine — RTK or TomoPy — 
as well as an algorithm and other settings for reconstructing projection data. You should 
note that this software release includes an implementation of the Simultaneous 
Algebraic Reconstruction Technique (SART) iterative algorithm for reconstructing cone-
beam projections, as shown below.

NOTE Refer to the following paper for more information about SART: A.H.Andersen, A.C.Kak, 
Simultaneous Algebraic Reconstruction Technique (SART): A superior implementation of 
the ART algorithm. Ultrasonic Imaging, Volume 6, Issue 1, January 1984, Pages 81-94 
(https://doi.org/10.1016/0161-7346(84)90008-7).

In addition, the RTK reconstruction engine with the FDK algorithm is now available for 
parallel-beam reconstructions, as shown below.

Find Rotation Center… Opens the CT Rotation Finder dialog, in which you can find and 
apply the optimal rotation center offset.

Pre-processing… The Pre-processing options let you choose to apply flat-field 
corrections, median filtering, and other corrections to improve image quality. The 
available options now include a multi-point piecewise flat field correction option for 
removing ring artefacts that can influence CT-based measurements.

Preview… Lets you compute previews at the selected settings, as well as to import the 
settings from a selected preview.

Reconstruction… Lets you reconstruct projections at the selected settings. You can 
choose to automatically load the computed reconstruction into Dragonfly or to 
reconstruct and save the selected dataset. You may need the latter if your system 
memory is not sufficient for loading reconstructed datasets.

NOTE The Output dimensions box, which was previously available to show the properties of the 
output dataset, was deprecated in this software release. These properties are not 
editable and were previously provided for informational purposes only.
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MC X-Ray

For MC X-Ray, this software release includes the option to display the results of BSE and 
EDS maps. You should note that MC X-Ray lets you simulate electron scattering in 
materials in order to correlate X-Ray emission to composition in quantitative X-ray 
microanalysis. By simulating X-ray spectra, it is possible to establish the optimum 
conditions to perform a specific analysis, as well as to establish detection limits or to 
explore possible peak overlaps.

Choose Workflows > MC X-Ray Simulator to open the MC X-Ray dialog. In MC X-Ray, you 
can compute the complete X-ray spectra from the simulation of electron scattering in 
solids of various types of geometries and allows for up to 256 different regions in the 
materials having the shape of spheres, cylinders, and combinations of horizontal and 
vertical planes. All of these regions can have a different composition.

NOTE The MC X-Ray module is only available as beta in this software release.

Slice Registration

A number of updates are available for Dragonfly’s Slice Registration module, which lets 
you automatically align slices within a 3D image stack. You should note that building a 
consistent stack of images helps ensure the accuracy of subsequent processing and 
analysis.

Additional Registration Method

A new registration method, known as ‘A Pyramid Approach’, is now available for 
registering image slices. This registration method provides automated sub-pixel 
registration by minimizing the mean square difference of intensities between a 
reference and target image slices.

Right-click the image stack that you need to align in the Data Properties and choose 
Slice Registration in the pop-up menu to open the Slice Registration panel, shown 
below. 

Slice Registration panel
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The following settings are available for the ‘A Pyramid Approach’ registration method.

Settings for ‘A Pyramid Approach’

NOTE This registration method is based on the following paper: P. Thévenaz, U.E. Ruttimann, 
M. Unser, A Pyramid Approach to Subpixel Registration Based on Intensity. IEEE 
Transactions on Image Processing, Vol. 7, No. 1, Pages 27-41, January 1998 (doi: 
10.1109/83.650848).

Additional Feature Detector

An additional feature detector, known as SIFT (scale-invariant feature transform), is 
now available whenever you work with the Feature Base registration method. In this 
case, keypoint detectors and extractors are applied to detect stable keypoints and to 
select the strongest features. In many cases, SIFT can identify keypoints among clutter 
and under partial occlusion as it is invariant to uniform scaling, orientation, illumination 
changes, and is partially invariant to affine distortion.

Choose Feature Base as the Registration method in the Slice Registration dialog and 
then SIFT as the Feature detector, as shown below.

Slice Registration panel   

Description

Motion Lets you choose the type of motion(s) that will be allowed when applying the geometric transform to 
register image slices.

Translation… Sets a translational transformation as the motion model.

Rigid body (translation + rotation)… Sets a translational and rotational transformation as the motion 
model.

Reference slice Lets you choose the reference slice — Previous, First, or Mean — to which other slices in the image stack 
will be registered.

Information Opens the Acknowledgment and Reference dialog, in which the original author is credited and the 
reference publication is cited.
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Report Generator

As an update for Dragonfly’s Report Generator, you can now create summary reports 
that include and summarize the results from a number of analyses. 

Choose Utilities > Report Generator to open the Report Generator dialog, shown below. 
You can then add the analysis results for multiple samples, select a summary report 
template, and then generate your summary report.

Report Generator dialog

The following settings are available in the Report Generator dialog for creating summary 
reports. Additional information about reports is available in the Developer 
Documentation for Dragonfly 2022.1 (see Reports on page 51).

Report Generator settings

Description

Data (XML) Lets you choose the data that you want to include in generated reports.

Add Files… Opens the Select the input file(s) dialog, in which you can choose the XML files for the 
generated report.

Add Folder… Opens the Select the input folder dialog, in which you can choose the folder that contains 
the XML files you want to include in the generated report. In this case, all XML files in the selected folder 
will be added to the Data (XML) box.

NOTE The paths in selected XML files will be updated automatically to avoid having to copy referenced 
files and folders.

Remove… Lets you remove a selected XML file.

Export as Merged XML… Exports all of the added XML files to a single XML file for debugging XSLT 
transformations.
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H5 File Importer

For Dragonfly Pro users, this software release includes improvements for importing files 
created with Xnovo’s GrainMapper3D software (*.h5 extension).

Choose File > Import GrainMapper3D Result File (h5) on the menu bar to import a 
selected GrainMapper3D file. As shown below, you can now select which data objects to 
import in the Select Data to be Imported dialog, as shown below.

Select Data to be Imported dialog

NOTE GrainMapper3D, which provides non-destructive 3D crystallographic imaging through 
LabDCT on ZEISS Xradia 520/620 Versa X-ray microscopes made for laboratory use, is 
a registered trademark of Xnovo Technology ApS.

NOTE This option is available for Dragonfly Pro only. Contact sales@theobjects.com for 
information about the availability of this version of Dragonfly

Transformation (XSLT) Lets you choose a report template from available XSLT files. XSLT (extensible stylesheet language 
transformations) is a language for transforming XML documents into other XML documents or formats, 
such as PDF or HTML for web pages.

NOTE As shown below, customized reports can include additional data, such plots of labels counted and 
labels passed, for all included input files.

NOTE Custom report templates can be developed upon request. Contact your sales representative at 
sales@theobjects.com for more information about customized reports.

Report file Lets you choose a file name and location for generated reports.

Description
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Image Loader

Dragonfly’s Image Loader now supports JPEG 2000, as well as previews and settings for 
importing image data saved in the ORS Object file format.

Support for JPEG 2000

This software release includes support for importing files saved in the JPEG 2000 (*.jp2 
extension) file format, as well as for exporting files in the JPEG 2000 file format.

Although not widely adopted, the lossy JPEG 2000 file format can provide better 
compression performance with improved image quality compared to the original JPEG 
file format. A higher dynamic range is also supported by this format, with no limit to 
image bit depth.

Previews and Settings for ORS Object files

You can now preview files saved in the ORS Object (*.ORSObject extension) file format 
before they are imported into Dragonfly. This update also includes the option to modify 
the settings for image sampling and spacing, invert axes and apply axis 
transformations, as well as to crop selected files before loading.

Select the file you want to preview in the Import Image dialog and then click the See 
Preview button to open the Preview window, as shown below. Information about the 
composition of the image file, as well as a Z-slice slider for scrolling through the image 
slices, is available in the Preview window.

Image Loader preview

NOTE Previews are only available for ORS Object files that contain a single channel.
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Workspace Panel Reformatting

To help optimize your workspace, this software release includes a minor reformatting of 
the tools and settings panels available by default on the Main tab. In this software 
release, collapsed panels that are docked at the top of the workspace will only take a 
minimum amount of space. This can let you better customize your workspace, as shown 
below.

Dragonfly workspace

Layout Panel

The updated Layout panel for Dragonfly 2022.1, shown below, includes a more 
comprehensive collection of buttons for setting the number and type of views in the 
selected scene.

Layout panel

You should note that any of the scene views layouts can be selected as the default 
scene layout in the Preferences dialog, as shown below.

Views preferences
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3D Visualizations

A number of new options and settings are available in this software release to help 
optimize your 3D visualizations.

Virtual Floor Panel

This software release features a new Virtual Floor panel that lets you fine-tune the floor 
settings. The Virtual Floor panel, shown below, is available on the left sidebar.

Virtual Floor panel and rendering with a virtual floor

The following settings are available for virtual floors. You should note that virtual floors 
are computed in reference to the selected dataset and are bound to its bounding box.

Virtual floor settings

Description

Virtual floor If selected, a virtual floor will appear in the selected 3D view.

Reflective surface If selected, the surface of the virtual floor will reflect the visible objects in the 3D view.

Reflective surface slider… Lets you control the opacity and reflectiveness of the floor.

Color Lets you choose a floor color in the Color Choose dialog.

Distance Lets you adjust the distance between the floor and the objects in the 3D view.

Position Lets you choose the position of the floor — +X, -X, +Y, -Y, +Z, or -Z — as shown below.

NOTE In previous versions, the floor was computed automatically from the ‘up’ position of the camera.

Tilt Lets you fine-tune the position of the floor by applying tilts up to 45° along the XY, XZ, and YZ axes.
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3D Presets

This software release provides a number of new 3D presets for core samples and 
organic material, as well as bi-tone presets that you let you use black backgrounds for 
creating dramatic images. You should note that applying a 3D preset lets you quickly 
apply 3D settings, scene’s views properties, lighting effects, focus, and LUTs to optimize 
3D visualizations. 3D presets are available for the selected dataset on the Data 
Properties and Settings panel, as shown below.

3D presets

Below are examples of the new 3D presets for core samples.

3D presets for core samples

Below are examples of the new bi-tone 3D presets.

Bi-tone 3D presets

Rocks1 Rocks2 Rocks4

Bitone1 Bitone2 Bitone3



40 New Feature s  and Produc t  Enhancement s
3D Visualizations

Dragonfly Release Notes Version 2022.1

T
M

0
2

1
-A

-1
1

Below are examples of the new 3D presets for sand and wood.

3D presets

Clip Box Preferences

A new preference, ‘Show captions’, circled below, is now available to show or hide the 
axis captions of clip boxes in 3D views by default.

3D Settings preferences

Scene’s Views Properties Settings

The ‘Accurate depth sorting’ item on the Scene’s Views Properties panel was deprecated 
in Dragonfly 2022.1. In this new release, accurate depth sorting is activated 
automatically through the ‘Maximize quality’ item on the Scene’s Views Properties 
panel. This setting now changes both the raycasting step, as well as enables accurate 
depth sorting to remove dithering.

Sand2 Wood
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ROI Painter Tools

For editing the results of automated segmentations and other tasks, a new ‘Point & Click 
Fill’ brush is available on the ROI Painter panel. This tool automatically fills the inner 
enclosed areas within a region of interest or multi-ROI class based on the connectivity 
of unlabeled pixels or voxels.

Point & Click Fill brush

As shown below, you can fill inner enclosed areas with a single click when you use the 
Point & Click Fill brush.

Filling an enclosed area
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Multi-ROIs

A number of new options — which include exporting class histograms to line-based CSV 
files, generating a Points set of the centroids of all labeled objects, and cross-indexing 
— are available for multi-ROIs in this software release

Export Multi-ROI Class Histograms

If required, you can now export selected class histograms to line-based CSV files.

Line-based CSV (top) and CSV (bottom)

Do the following to export multi-ROI class histograms:

1. Select the classes of the multi-ROI that you want to include in the exported CSV file 
in Classes and scalar information box.

2. Right-click the multi-ROI and then choose Export > Selected Classes Histograms to 
Line-Based CSV in the pop-up menu.

3. Choose the image from which the histogram data will be extracted in the Choose an 
Image to Create Histograms dialog.

4. Click OK to generate the line-based CSV file.
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Generate Object Centroids

For some analysis tasks, you may need to find the centroids of the labeled objects in a 
multi-ROI. A new utility in 2022.1 now lets you automatically generate a Points set of 
the centroids of each labeled object in the selected multi-ROI, as shown below.

Right-click the required multi-ROI and then choose Generate Centroids in the pop-up 
menu to create a Points set.

Generated centroids

Cross Indexing for Multi-ROIs

Available in the Scalar Generator, this option lets you cross index the label number of 
the intersecting classes of another multi-ROI to a selected multi-ROI’s classes (see 
Cross Indexing on page 24).
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Annotations

This software release includes a number of updates and new options for rulers, paths, 
and shapes.

Captions

For rulers, angles, regions, and other annotations, you can now adjust font size of 
captions for each annotation with the Increase font size and Decease font size buttons, 
as shown below.

Font size adjustments

Ruler Properties

You should note that in this software release the orientation of projected rulers is now 
described as ‘Left/right’ and ‘Top/bottom’ and is selectable as shown below.

Ruler properties
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Align Current View Normal to Ruler

Available in the pop-up menu for rulers, the option Align Current View Normal lets you 
automatically align the current view to the normal of a selected ruler.

Original view with ruler (on left) and aligned view (on right)

Generating Tubular Meshes from Paths

This software release provides the option to quickly and efficiently convert paths to 
tubular meshes. The main advantage is the easy control and editing of paths — you can 
move its points to change the shape of the curve, add new points, and delete 
unnecessary ones. Smoothing and resampling are also available for paths. For 
generated tubular meshes, curvature, deviation maps, surface area, and other 
parameters are readily available.

Right-click the required path in the Data Properties and Settings panel and then choose 
Generate Mesh Tube in the pop-up menu. You can then choose a fixed radius for 
generating the tubular mesh in the Radius of mesh tube dialog. 

Tubular mesh (on left) and original path (on right)
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Shapes

A number of updates are available for shapes in Dragonfly 2022.1.

Add to New ROI

This new option for shapes, such as boxes, capsules, cylinders, and spheres, lets you 
label all voxels contained in the sub-volume defined by the current shape and them add 
them to a new region of interest.

Right-click the required shape and choose Add to ROI in the pop-up menu. You can then 
select New ROI in the Choose an ROI dialog, shown below, as well as a name, highlight 
color, and geometry in the New region of Interest dialog.

TITLE HERE 

Borders

If required for a specific workflow, you can now set which shape borders and anchors 
are selectable and can be manipulated. An example of the main code in the Script 
Runner dialog for setting the state of highlightable borders is shown below.

Main code box in the Script Runner dialog
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Macros

A number of updates are available for Dragonfly’s Macro Player in this software release. 
These include the following:

• Simple double-click to edit step titles and/or descriptions, as shown below.

• Toggle on action, for example Play, Stop, and so on.

• The option to include deep learning model inference in a macro.
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Checking for Software Updates

All Dragonfly customers receive notification of new software releases, which contain 
new features, performance improvements, bug fixes, and other important changes. 
Windows users can now also check periodically for new program releases to ensure that 
their system is up-to-date.

NOTE Commercial users must have a valid Maintenance & Support plan to be eligible for a new 
version. Non-commercial users must have a current non-commercial license.

Checking For and Installing New Releases (Connected Systems)

Refer to instructions below if your system is connected to the Internet. In this case, the 
Check for Updates command will automatically scan your computer to check the current 
version and then send this information to Object Research Systems for comparison. If 
an update is available, you can then simply download the new version and it will be 
installed automatically.

1. Open Dragonfly.

2. Choose Help > Check for Updates on the menu bar.

3. Do one of the following;

• If the Update is Available message box appears and you decide to install the new 
version, click Download and Install.

In this case the new version will be downloaded and installed automatically. You 
should note that Dragonfly will close during this operation and that your license 
will be updated automatically.

• Click OK if the Check for Updates dialog indicates that you are using the most 
up-to-date production release of Dragonfly.

Checking For and Installing New Releases (Offline Systems)

In cases in which your system runs offline, you can still check for updates by creating a 
scripted ‘Check for Updates’ file and then running that file on a connected system. If an 
update is available, you can then download the new version on that system and transfer 
the Dragonfly installer and new license to your offline system.

1. Open Dragonfly.

2. Choose Help > Create Update Information File on the menu bar.

3. Click Yes in the Updates dialog to create a ‘CheckForUpdates’ HTML file.

4. Transfer the ‘CheckForUpdates.html’ file to a connected system that has an Internet 
browser.

NOTE You can transfer the file with a portable drive, such as a USB stick, or through 
your local area network.

5. Open the ‘CheckForUpdates.html’ file in a browser, such as Google Chrome or 
Microsoft Edge.
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6. Do one of the following;

• If a new production release is available, and you decide to install the new 
version, click Update Dragonfly.

In this case, you will be prompted to first save a license file and then the 
Dragonfly installer. You should note that both files must be saved and transferred 
to the offline machine that you want to update.

• Close the page if you receive the message that you are using the most up-to-
date production release of Dragonfly.

7. Transfer the Dragonfly installer, along with your new license, to the system you need 
to update.

8. Run the Dragonfly installer on your offline system.
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Developer Documentation
A number of major additions to the developer documentation is available for this 
software release. These include new sections for conditional actions, wizards, and 
reports.

Choose Developer > Developer Documentation on the menu bar to open the latest 
version of the Dragonfly developer documentation.

Actions                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                          

To help further explain the logic of actions, the developer documentation for Dragonfly 
2022.1 was updated with detailed flowcharts explaining the analysis of Qt events and 
translation into actions. Documentation about actions can be found at:

dev.theobjects.com/dragonfly_2022_1_release/ORSServiceClass/decorators/
sphinxIndexdecorators.html#action

This update also includes a new video that provides in-depth explanations about the 
processing of events into actions.

Dragonfly Actions Infrastructure Explanations video

NOTE This video is available on the Object Research Systems’ YouTube channel at
https://youtu.be/Q-h6ASfFKXs.
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Wizards

To help external developers create specialized workflows, the developer documentation 
now includes a section dedicated to wizards. Wizards are a specialized context that can 
be used to guide users through an orderly set of tasks.

Documentation about wizards are be found at:

dev.theobjects.com/dragonfly_2022_1_release/Documentation/Infrastructure/
contexts.html#wizards

You should note that this new section also includes detailed flowcharts of the 
architecture of wizards in the PDF file format.

Reports

In many cases, the output of a specialized workflow is a set of data and images that is 
best presented in a customized report or summary report. To help authors better 
understand the structure of the XML data files, merged XML data, and XSL 
transformation files used to generate PDFs, the developers documentation now includes 
a dedicated Reports section.

You can access information about report generation at:

dev.theobjects.com/dragonfly_2022_1_release/Documentation/Infrastructure/
reports.html
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Menu Bar Changes
The following new items are available on the menu bar in Dragonfly 2022.1. Other 
changes are also listed here.

Workflows Menu

A number of changes, listed below, were implemented in the Workflows menu.

Workflows menu changes

Artificial Intelligence Menu

A number of new items, listed below, are available in the Artificial Intelligence menu.

Artificial Intelligence menu changes

Help Menu

A number of new items, listed below, are available in the Help menu.

Help menu changes

Description

PuMA Opens the PuMA dialog, in which you can perform material response simulations (see Porous 
Microstructure Analysis (PuMA) on page 6).

Description

Custom Deep Model 
Architectures

Includes the option Noise2Void, which opens the Noise2Void dialog (see Noise2Void Deep Learning 
Model for Denoising on page 9).

Description

Request Non Commercial 
License

You should note that the mechanism for requesting a non-commercial license was streamlined for this 
software release. The new web-based request form appears as shown below.

Check for Updates Lets you check for new program releases from a system connected to the Internet (see Checking for 
Software Updates on page 48).

Create Update Information 
File

Lets you check for new program releases for an offline system (see Checking for Software Updates on 
page 48).
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Changes to Contextual Menus
The following changes for the contextual menus available in the Data Properties and 
Settings panel are implemented in Dragonfly 2022.1.

Dataset Menu

A number of new items, listed below, are available in the Dataset pop-up menu.

Dataset pop-up menu changes

ROI Pop-Up Menu

A number of new items, listed below, are available in the ROI pop-up menu.

ROI pop-up menu changes

Multi-ROI Pop-Up Menu

A number of new items, listed below, are available in the Multi-ROI pop-up menu.

Multi-ROI pop-up menu changes

Mesh Pop-Up Menu

A number of new items, listed below, are available in the Mesh pop-up menu.

Mesh pop-up menu changes

Description

Generate Vector Field from 
Datasets

Lets you generate a vector field from selected datasets (see Vector Fields from Datasets on page 25).

Description

3D Modeling Includes the option Create an Anisotropy Vector Field, which opens the Create an Anisotropy Vector Field 
dialog (see Anisotropy Vector Fields on page 27).

Description

Export Selected Classes 
Histograms to CSV Line 
Based

Lets you export selected class histograms to line-based CSV files (see Export Multi-ROI Class 
Histograms on page 42).

Generate Centroids Lets you create a Points Set that marks the centroid of each labeled object in the multi-ROI (see Generate 
Object Centroids on page 43).

Description

3D Modeling Includes the option Create an Anisotropy Vector Field, which opens the Create an Anisotropy Vector Field 
dialog (see Anisotropy Vector Fields on page 27).
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Graph Pop-Up Menu

A number of new items, listed below, are available in the Graph pop-up menu.

Graph pop-up menu changes

Annotations Pop-Up Menu

A number of new items, listed below, are available in the Annotations pop-up menus.

Annotations pop-up menu changes

Description

Graph Tortuosity Analysis Lets you analyze tortuosity between selected input and output boxes (see Tortuosity Analysis for Graphs 
on page 28).

Graph Throat Weighted 
Tortuosity Analysis

Lets you analyze throat-weighted tortuosity between selected input and output boxes (see Tortuosity 
Analysis for Graphs on page 28).

Description

RULERS

Align Current View Normal to 
Ruler

Lets you automatically align the current view to the normal of the selected ruler (see Align Current View 
Normal to Ruler on page 45).

PATHS

Generate Mesh Tube Lets you quickly and efficiently convert paths to tubular meshes (see Generating Tubular Meshes from 
Paths on page 45).
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System Requirements
This release supports the base system requirements for Windows and Linux.

NOTE You should note that as of Dragonfly version 2021.3, an AVX compliant CPU is required 
(refer to en.wikipedia.org/wiki/Advanced_Vector_Extensions#CPUs_with_AVX for a 
list of AVX compatible CPUs).

Third-Party Packages

You should note that there are no changes for the third-party packages listed below.

Third-party packages

Publicly Available Source Code
Users can freely download and examine the source code of the following.

TensorFlow

A number of Dragonfly’s artificial intelligence applications, such as the Deep Learning 
Tool, the Segmentation Wizard, and Segment with AI, use TensorFlow APIs to facilitate 
training and inference of deep neural networks. Created by the Google Brain team, 
TensorFlow is a free and open-source library widely used for deep learning applications 
and traditional machine learning.

Users can freely download and examine the TensorFlow source code from:
https://github.com/tensorflow/tensorflow/releases/tag/v2.4.1.

Qt

Dragonfly is designed and developed with Qt, which is a free and open-source toolkit for 
creating graphical user interfaces and cross-platform applications. Qt is developed by 
The Qt Company, a publicly listed company, and is available under both commercial 
licenses and open-source GPL 2.0, GPL 3.0, and LGPL 3.0 licenses.

Users can freely download and examine the Qt source code from:
https://download.qt.io/official_releases/qt/5.12/5.12.9/.

Item 2022.1 Previous release

TensorFlow 2.4.1 2.4.1

Qt 5.12.9 5.12.9

Python 3.8.6 3.8.6
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Porous Microstructure Analysis (PuMA)

The Porous Microstructure Analysis (PuMA) software integrated in Dragonfly was 
developed by researchers at NASA to compute effective material properties and perform 
material response simulations on digitized microstructures of porous media. PuMA is 
able to generate artificial microstructures that mimic real materials and to compute 
simple morphological properties such as porosity, volume fractions, pore diameter, and 
specific surface area. Additional capabilities include the determination of effective 
thermal and electrical conductivity (both radiative and solid conduction - including the 
ability to simulate local anisotropy for the latter); effective diffusivity and tortuosity 
from the continuum to the rarefied regime; techniques to determine the local material 
orientation, as well as the mechanical properties (elasticity coefficient), and the 
permeability of a material.

PuMA is available under the terms of the NASA Open Source Agreement (NOSA) and is 
a copyright of the United States Government as represented by the Administrator of the 
National Aeronautics and Space Administration.

Stable releases of PuMA can be found on the official NASA GitHub repository at:
https://github.com/nasa/puma.

The latest development code can be found on the development GitLab repository at:
https://gitlab.com/jcfergus/puma-dev.

Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Utilities > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.
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Learning Dragonfly
You’ll find some great free resources, such as our latest instructional videos, recorded 
webinars, and user forums just by taking a quick look around www.theobjects.com/
dragonfly/. You can also take advantage of the course offerings listed below to further 
benefit from our training team's in-depth product knowledge.

Dragonfly Workshops

Our hands-on training workshops are a great way to get up and running quickly. 
Combining in-depth instruction with class exercises, our product specialists will quickly 
teach you how to use key Dragonfly features and functions to optimize your image 
visualization and analysis tasks.

NOTE All scheduled Dragonfly workshops have been postponed or canceled due to concerns 
about COVID-19. We will resume our workshop schedule as soon as possible. You can 
check for updates at http://www.theobjects.com/dragonfly/workshops.html.

Online Training

Get connected with an online training session and follow along with a Dragonfly product 
specialist as they demonstrate the features and benefits of Dragonfly and walk you 
through specialized modules. Web-based training, which can be adapted to individual 
needs and interests, offers an interactive approach that lets you practice new 
techniques on numerous case studies.

NOTE Online training is available upon request. Contact support@theobjects.com for 
information about availability.
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Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > Report 
an Issue on the menu bar.
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